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2 Important notice

NXP provides the enclosed product(s) under the following conditions:

This evaluation kit is intended for use of ENGINEERING DEVELOPMENT OR
EVALUATION PURPOSES ONLY. It is provided as a sample IC pre-soldered to a
printed circuit board to make it easier to access inputs, outputs, and supply terminals.
This evaluation board may be used with any development system or other source of
I/O signals by simply connecting it to the host MCU or computer board via off-the-
shelf cables. This evaluation board is not a Reference Design and is not intended to
represent a final design recommendation for any particular application. Final device in
an application will be heavily dependent on proper printed circuit board layout and heat
sinking design as well as attention to supply filtering, transient suppression, and I/O
signal quality.

The goods provided may not be complete in terms of required design, marketing, and
or manufacturing related protective considerations, including product safety measures
typically found in the end product incorporating the goods. Due to the open construction
of the product, it is the user's responsibility to take any and all appropriate precautions
with regard to electrostatic discharge. In order to minimize risks associated with the
customers applications, adequate design and operating safeguards must be provided
by the customer to minimize inherent or procedural hazards. For any safety concerns,
contact NXP sales and technical support services.

Should this evaluation kit not meet the specifications indicated in the kit, it may be
returned within 30 days from the date of delivery and will be replaced by a new kit.

NXP reserves the right to make changes without further notice to any products herein.
NXP makes no warranty, representation or guarantee regarding the suitability of its
products for any particular purpose, nor does NXP assume any liability arising out of the
application or use of any product or circuit, and specifically disclaims any and all liability,
including without limitation consequential or incidental damages. “Typical” parameters
can and do vary in different applications and actual performance may vary over time.
All operating parameters, including “Typical”, must be validated for each customer
application by customer’s technical experts.

NXP does not convey any license under its patent rights nor the rights of others. NXP
products are not designed, intended, or authorized for use as components in systems
intended for surgical implant into the body, or other applications intended to support or
sustain life, or for any other application in which the failure of the NXP product could
create a situation where personal injury or death may occur.

Should the Buyer purchase or use NXP products for any such unintended or
unauthorized application, the Buyer shall indemnify and hold NXP and its officers,
employees, subsidiaries, affiliates, and distributors harmless against all claims, costs,
damages, and expenses, and reasonable attorney fees arising out of, directly or
indirectly, any claim of personal injury or death associated with such unintended or
unauthorized use, even if such claim alleges NXP was negligent regarding the design or
manufacture of the part.

NXP and the NXP logo are trademarks of NXP B.V. All other product or service names
are the property of their respective owners. © NXP B.V. 2018.
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3 Overview

The FRDMPT2001EVM evaluation module provides a platform for developing and
testing automotive fuel-injection control systems based on NXP’s PT2001 direct
injection predriver IC. The FRDMPT2001EVM contains PT2001 Programmable Solenoid
Controller (PSC) and provides connections for up to four fuel injectors, two fuel pumps
(half-bridge) and a DC/DC converter.

The evaluation module consists of the FRDMPT2001EVM board and an MCU companion
board plugged on the bottom.

Two options are provided for the MCU companion:

1. FRDM-KL25Z board (default configuration) allows the developer to use NXP’s
SPIGen software to directly access the PT2001 on the FRDMPT2001EVM board. This
also allows the developer to be quickly familiar with PT2001 without having the need
to write any MCU code (see Section 5.3 "FRDM-KL25Z board").

2. S32K144EVB-Q100 board, this kit includes the MCU S32K144 an automotive Kinetis
processor which offers the high-speed performance required to evaluate PT2001
automotive fuel system designs. NXP’s S32 Design Studio software serves as the
platform for developing application-specific MCU code and downloading it to the
S32K144EVB-Q100 through the OpenSDA port.

For both MCU kits, the developer interacts with the PT2001 by connecting a USB
cable between a USB port on a host PC and a mini or micro USB port on the MCU kits.
Programming the PT2001 microcode and setting initial register should be done using
PT2001 Developer Studio software.
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4 Getting started

The NXP analog product development boards provide an easy-to-use platform for
evaluating NXP products. These development boards support a range of analog, mixed-
signal, and power solutions. These boards incorporate monolithic integrated circuits and
system-in-package devices that use proven high-volume technology. NXP products offer
longer battery life, a smaller form factor, reduced component counts, lower cost, and
improved performance in powering state-of-the-art systems.

The tool summary page for FRDMPT2001EVM is at http://www.nxp.com/
FRDMPT2001EVM. The overview tab on this page provides an overview of the device, a
list of device features, a description of the kit contents, links to supported devices and a
Get Started section.

The Get Started section provides information applicable to using the FRDMPT2001EVM.

1. Go to http://www.nxp.com/FRDMPT2001EVM.
2. On the Overview tab, locate the Jump To navigation feature on the left side of the

window.
3. Select the Get Started link.
4. Review each entry in the Get Started section.
5. Download an entry by clicking on the linked title.

After reviewing the Overview tab, visit the other related tabs for additional information:

• Documentation: Download current documentation.
• Software & Tools: Download current hardware and software tools.
• Buy/Parametrics: Purchase the product and view the product parametrics.

After downloading files, review each file, including the user guide, which includes setup
instructions. If applicable, the bill of materials (BOM) and supporting schematics are also
available for download in the Get Started section of the Overview tab.

4.1 Kit contents/packing list
The FRDMPT2001EVM contents include:

• Assembled and tested FRDMPT2001EVM board mounted to a FRDM-KL25Z board in
an anti-static bag

• S32K144EVB-Q100 in case a higher performance MCU is required
• Quick start guide
• Warranty card

4.2 Required equipment
To use this kit, you need:

• 1/8” blade screwdriver for connecting the loads
• DC power supply: 12 V with minimum 5.0 A current handling capability, depending on

load requirements
• USB Standard A (male) to micro-B (male) cable (for included K144 Freedom board)
• USB Standard A (male) to mini-B (male) cable (for KL25Z Freedom board)
• Typical loads (direct injection fuel injectors)
• FRDM-KL25Z Freedom Development Platform for SPI communication
• NXP SPIGen software (for use with FRDM-KL25Z based SPI Dongle)

http://www.nxp.com/FRDMPT2001EVM
http://www.nxp.com/FRDMPT2001EVM
http://www.nxp.com/FRDMPT2001EVM
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• NXP's S32 Design Studio software (for use with the S32K144EVB-Q100)
• NXP's PT2001 Developer Studio (for use with the FRDMPT2001EVM)

4.3 System requirements
The kit requires the following to function properly with the software:

• A USB enabled computer with Windows 7 or later

5 Getting to know the hardware

The FRDMPT2001EVM consists of two boards:

• the FRDMPT2001EVM board and an attached FRDM-KL25Z board (SPIGEN can be
used in this configuration)

• an optional S32K144EVB-Q100 may also be used with the FRDMPT2001EVM

The following sections describe all three boards.

5.1 FRDMPT2001EVM board

5.1.1 Board overview

The FRDMPT2001EVM serves as the interface between the PT2001 and the
components it controls. The board contains a commercial version of the PT2001 and
connectors for up to four fuel injectors, two fuel pumps and a DC/DC converter.

5.1.2 Board features

The board features are as follows:

• PT2001 direct injection predriver integrated circuit
• external MOSFETs
• power-conditioning circuitry
• +12 V to +36 V VSUPP power to the PT2001
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5.1.3 Block diagram
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Figure 2. Block diagram

Note: The PT2001 supports up to 72 V on the battery line, but the SBC UJA1169
on S32K144 kit only supports 40 V as maximum rating and 28 V full performance.
Therefore, the board supply should be limited to 28 V or the MCU kit should be supplied
externally (R104 resistor to be removed in this case).
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5.1.4 Device features

Table 1. Device features
Device Description Features

PT2001 Programmable solenoid controller,
five high-side and seven low-side
controls

• Battery voltage range, 5.5 V < VBATT < 32 V
• Predrive operating voltage up to 72 V
• High-side/low-side predrive PWM capability up to 100 kHz
• Four selectable slew rates with all predrivers
• Eight selectable, predefined VDS monitoring thresholds
• Encryption for microcode protection
• Integrated 1.0 MHz back-up clock

S32K144 MCU Microcontroller • 112 MHz ARM Cortex-M4 core with SFPU
• Modified Harvard architecture to support tightly coupled

RAM and 4 KB I/D cache
• Hardware security engine supporting SHE specification
• 128-bit unique identification (UID) number per chip
• Internal 48 MHz RC (IRC) oscillator
• Up to six FlexCAN, a maximum of two with FD support
• FlexIO emulating communication protocols (example, SPI,

UART, and so on)
• Supports ISO 26262 ASIL B

MKL25Z128VLK4 MCU Microcontroller • Cortex-M0+ core running at up to 72 MHz (up to 96 MHz
for high-speed run) over full voltage and temperature range
(−40 ˚C to +105 ˚C)

• Up to 512 KB flash with 64-byte flash cache, up to 128 KB
RAM

• 16 to 32 KB ROM with integrated bootloader
• Security circuitry to prevent unauthorized access to RAM

and flash contents
• Up to 16-bit ADC with configurable resolution, sample

time and conversion speed/power. Integrated temperature
sensor. Single or differential input mode operation in order
to achieve improved noise rejection.

• High-speed comparator with internal 6-bit DAC
• One six-channel and two 2-channel,16-bit low-power timer

PWM modules with DMA support

5.1.5 Board description

Figure 3. Board description
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Table 2. Board description
Number Name Description

1 PT2001 Programmable solenoid controller

2 Pi filter Circuitry to remove undesired frequencies

3 DC/DC DC/DC converter to generate BOOST voltage

4 Fuel pump One high-side and one low-side control for high pressure fuel pump

5 Injector Bank 1 Two high-side and two low-side controls for fuel injectors 1 and 2

6 Injector Bank 2 Two high-side and two low-side controls for fuel injectors 3 and 4

5.1.6 Test point definitions

Figure 4. Test point locations

Table 3. Test point definitions
Number Name Description

1 GND Ground test point

2 VCCP VCCP voltage

3 VSENSEP1 Positive current sense 1

4 G_LS1 Gate1 low-side

5 G_HS2 Gate2 high-side

6 G_HS1 Gate1 high-side
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5.1.7 Connectors

Figure 5. Connectors

Table 4. Input connectors
Name Description Connection

Screw terminal 1: Ground
JVBAT Power supply input

Screw terminal 2: 12 V to 28 V

Table 5. Output connectors
Name Description Connection

Screw terminal 1: low-side driveINJ2−

Screw terminal 2: high-side drive INJ2+

Screw terminal 3: high-side drive INJ1+
BANK1 Bank output 1 (injector1

and 2)

Screw terminal 4: low-side driveINJ1−

Screw terminal 1: low-side drive INJ4−

Screw terminal 2: high-side drive INJ4+

Screw terminal 3: high-side drive INJ3+
BANK2 Bank output 2 (injector3

and 4)

Screw terminal 4: low-side driveINJ3−

Screw terminal 1: low-side drive FP2−

Screw terminal 2: high-side drive FP2+

Screw terminal 3: high-side drive FP1+
FP Fuel pump output 1 and 2

Screw terminal 4: low-side drive FP1−

5.2 S32K144EVB-Q100 board
The S32K144EVB-Q100 features the S32K144 MCU, an automotive Kinetis processor
which provides the high-speed performance required to evaluate PT2001 automotive
fuel system designs. While the S32K144EVB-Q100 offers a range of capabilities, its
primary purpose when used with the FRDMPT2001EVM is to control SPI and digital I/O
communications with the PT2001.
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In that context, two on-board switches (SW2 and SW3) allow developers to control
the PT2001 when using the example projects provided on the FRDMPT2001EVM tool
summary page. The board also includes a potentiometer for RPM control and three LEDs
that light to indicate when a PT2001 fault occurs.

For additional information on this board, see http://www.nxp.com/S32K144EVB.

5.3 FRDM-KL25Z board
NXP’s Freedom development platform is a set of software and hardware tools that
provide an ideal platform for the rapid prototyping of microcontroller-based applications.
The FRDM-KL25Z board is a key component of the development platform.

The board features a Kinetis L Series microcontroller, the industry's first microcontroller
built on the Arm® Cortex®-M0+ processor. It makes use of the USB, the built in LEDs and
the I/O ports available with NXP’s Kinetis KL2x family of microcontrollers. When used in
conjunction with the FRDMPT2001EVM, the FRDM-KL25Z controls SPI communication
between the evaluation board and a PC. It permits the user to regulate the power outputs
and implement the features of the device on the evaluation board.

The FRDM-KL25Z also monitors the SPI registers, thereby facilitating the use of safety
and advanced diagnostic functions.

For additional information on the FRDM-KL25Z board, see https://www.nxp.com/FRDM-
KL25Z .

6 Operating the FRDMPT2001EVM with SPIGen and the FRDM-KL25Z

In the out-of-box configuration, the FRDMPT2001EVM’s PT2001 device can only be
exercised by downloading the appropriate microcode. To access the device’s registers
and internal memory, the developer must replace the S32K144EVB-Q100 with a FRDM-
KL25Z board. With the FRDM-KL25Z serving as an SPI dongle, the developer can then
use NXP’s SPIGen software to communicate with the device.

6.1 Preparing to use the FRDM-KL25Z
Before the FRDM-KL25Z can be used in conjunction with FRDMPT2001EVM board, the
following steps must be taken:

1. Install SPIGen on the host PC.
2. Download microcode to the FRDM-KL25Z.
3. Connect the FRDM-KL25Z to the FRDMPT2001EVM board.

The following sections describe each step in detail.

6.1.1 Installing SPIGen on the host PC

SPIGen currently runs on Windows 7, Windows 8 and Windows 10 operating systems.
The procedure for installing the software is as follows:

1. Go to the FRDMPT2001EVM tool summary page at http://www.nxp.com/
FRDMPT2001EVM and locate the Software & Tools tab.

2. From the list of files, download the SPIGen software as well as the associated
configuration files.

http://www.nxp.com/S32K144EVB
https://www.nxp.com/FRDM-KL25Z
https://www.nxp.com/FRDM-KL25Z
http://www.nxp.com/FRDMPT2001EVM
http://www.nxp.com/FRDMPT2001EVM
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Run the install program from the desktop. Follow the guidance of the installation wizard
through the rest of the process.

6.1.2 Connecting the FRDM-KL25Z to the FRDMPT2001EVM

When connected to the FRDMPT2001EVM board, the FRDM-KL25Z allows developers
to drive the evaluation board inputs to operate injectors or other solenoid loads via
the GPIOs and SPI pins. The FRDM-KL25Z can also read and write the SPI registers,
thereby allowing the user to modify PT2001 parameters and the advanced diagnostic
functions.

The procedure for configuring the FRDMPT2001EVM for use with the FRDM-KL25Z is as
follows:

1. Detach the S32K144EVB-Q100 from the FRDMPT2001EVM board.
2. Place connector blocks on the outer rows of all four Arduino connectors on the FRDM-

KL25Z.
3. Attach the FRDM-KL25Z under FRDMPT2001EVM board such that connector J3 on

the FRDMPT2001EVM aligns with connector J9 on the FRDM-KL25Z and connector
J2 on the FRDMPT2001EVM aligns with connector J2 on the FRDM-KL25Z.
 

 
4. Connect the Standard-A plug of the USB cable to the host PC. Connect the mini-B

plug on the cable to the port labeled USBKL25Z on the FRDM-KL25Z.

6.1.3 Downloading microcode to the FRDM-KL25Z

Note that this procedure requires a Standard-A (male) to mini-B (male) USB cable.

1. Go to the P&E Microcomputer Systems OpenSDA page at http://www.pemicro.com/
opensda and in the OpenSDAFirmware (MSD & Debug) box, click to download the
Firmware Apps zip file.
 

http://www.pemicro.com/opensda
http://www.pemicro.com/opensda
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2. When the download completes, unzip the file contents to a folder on the host PC.
3. Connect the Standard A plug of the USB cable to the host PC.
4. On the FRDM-KL25Z, press and hold down the Reset button. With the button

held down, attach the mini-B plug of the USB cable to the FRDM-KL25Z USB port
labeled SDA. Then release the Reset button. A blinking LED indicates the board is in
Bootloader mode.

5. Open Windows Explorer on the host PC. An icon labeled BOOTLOADER appears as
a removable drive on the PC.

6. From the files extracted from the PEMicro zip file, locate the driver file named
MSDDEBUG-FRDM-KL25Z_Pemicro_v118.SDA. Drag and drop this file onto the
BOOTLOADER icon.

7. Unplug the USB mini-B plug then re-insert the plug back into the SDA port. A blinking
LED on the board indicates that the FRDM-KL25Z is in bootloader mode.

8. Locate the SPIGEN UsbSpiDongleKL25Zv507.srec image folder in the SPIGEN
folder (C:\Program Files (x86)\SPIGen\SPI Dongle Firmware).

9. Copy and paste or drag and drop the .srec file to the FRDM-KL25Z removable drive
icon on the host PC.

10.Unplug the USB cable from the FRDM-KL25Z SDA port.
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6.2 Configuring the hardware for use with the FRDM-KL25Z
To run the examples included in the software bundle, the following connections and
setup must be performed:

1. Make sure SPIGen 7.0 (or higher) is installed on the PC and it can communicate with
the Freedom board FRDM-KL25Z. A blue LED, lights on the FRDM-KL25Z when
SPIGen is running and the board is properly connected.

2. Connect the FRDM-KL25Z to the PC using the USB KL25Z port (left side of SW1).
The USB_PWR LED on the FRDMPT2001EVM should be illuminated.

3. With the power supply switched off, attach the +12 VDC supply to the VSUPP input
connector on the FRDMPT2001EVM. Make sure that the power supply is connected
to the correct GND and +12 V terminals on the board. The current capability of the
+12 V supply must exceed the maximum total current required by the number of loads
that can be simultaneously ON.

4. Attach loads (Injectors) to the INJ1, INJ2, INJ3, INJ4, INJ5 and INJ6 output terminals
as desired.

5. Turn on the +12 V supply. The +5.0 V LED illuminates, indicating that the board is
properly connected.

Figure 6. Connecting equipment

6.3 Using SPIGen

6.3.1 Configuring the SPIGen software

1. In the Windows Start menu, go to Programs -> SPIGen and click the SPIGen icon.
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This icon appears on the Windows desktop if the appropriate option is selected during
installation.

2. When the SPIGen Graphical User Interface (GUI) appears, go to the file menu in the
upper-left corner and select Open. A file selection window opens. In the bottom-right
corner of the window, the drop-down box value should be set to SPIGen Files (*.spi).
If the configuration file name has a .txt extension, set this value to All Files (*.*).

3. Browse for the SPIGen configuration file downloaded from the tool summary page
(see Section 6.1.1 "Installing SPIGen on the host PC").
Select the configuration file and click Open. SPIGen creates a SPI command
generator configured specifically for the FRDMPT2001EVM board.

The GUI is shown in Figure 7. The text at the top is the name of the configuration file that
is loaded. The left side panel displays folders that group user interfaces. The interfaces
in the pre-installed PT2001 folder pertain specifically to the board FRDMPT2001EVM.
When the configuration file loads, SPIGen is assigned a FRDMPT2001EVM specific list
of Extra Pins and Quick Commands.

Figure 7. SPIGen PT2001 microcode user interface

6.3.2 Running an example file

1. With the FRDMPT2001EVM and FRDM-KL25Z configuration as described in
Section 6.2 "Configuring the hardware for use with the FRDM-KL25Z", launch the
SPIGen program.

2. Load the configuration file, by clicking File -> Open and browsing to the
KITPT2001SW.spi file located inside the Injector Demo Files directory.

3. In the Device View  panel, expand the PT2001 folder and click MicroCode.
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4. In the SPIGen menu bar, click Files -> Open and select the SPIGenPT2001Files.txt
included in the project example. All cells in the micro code page (Code Ramx, Data
Ramx, Channelx, Main, IO, and Diagnostics Configuration Registers) should populate
with the appropriate path.

5. Click Reset, Download and Enable to load and enable the PT2001.
6. In the Start Pulse Width (ms) cell, select the appropriate duration.
7. In the Device View  panel, in the PT2001 folder, click Channel Config. Select

Channel 1.
a. Check to assure that flash enable  is selected in the Register:cell.
b. Click Read and ensure that the checksum failure  bit is not set.
c. Make sure that bits 3, 4 and 5 are set as shown below.
 

 
8. Repeat the Channel Config process for Channel 2.

6.3.3 Reading and writing registers

SPIGen can also be used to read and write the registers on the PT2001. There are four
different register configuration pages under the PT2001 Device View:

• Channel configuration
• Main configuration
• IO configuration
• Diagnosis configuration

The channel configuration register page covers both channels and is shown in Figure 8.
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Figure 8. PT2001 channel configuration register page

To read or write a specific register on the PT2001, select the register name from the
Register drop-down on the top center of the page. The register address will be shown to
the right of the name. To read the contents of the register, click Read. The bits that are
set (1) are colored blue; the bits that are cleared (0) are colored white.

To write to a specific register, click on the bits to be changed to set them to the proper
state. Then click Write. The read and write process is the same for the other register
groups which can be accessed by clicking on the register group name under PT2001 in
the Device View  window.

7 Operating the FRDMPT2001EVM with the S32K144EVB-Q100

The FRDMPT2001EVM ships with a S32K144EVB-Q100 board. It can be attached
via Arduino™ connectors on the bottom side of the FRDMPT2001EVM board. In this
configuration, the PT2001 functionality can only be exercised by downloading the
appropriate microcode to the device.

7.1 Configuring the hardware for use with the FRDMPT2001EVM
1. Connect the micro-B plug on the USB cable to the USB port on the S32K144EVB-

Q100 board. Connect the USB cable’s Standard A plug to the host PC. An icon
named EVB-S32K144 appears as a removable drive on the host PC.
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2. With the power supply switched off, attach the +12 VDC supply to the VSUPP

input connector on the FRDMPT2001EVM board. Make sure that the power supply
is connected to the correct GND and +12 V terminals on the board. The current
capability of the +12 V supply must exceed the maximum total current required by the
number of loads that can be ON simultaneously.

3. Attach loads (Injectors) to the INJ1, INJ2, INJ3, and INJ4 output terminals as desired.
4. Turn on the +12 V supply. The +5.0 V LED illuminates, indicating that the board is

properly connected.

7.2 Downloading microcode
To use the FRDMPT2001EVM in a development environment, the developer must install
an NXP Integrated Design Environment (IDE) to download and run microcode. The
procedure for downloading microcode differs depending on whether the microcode is
being downloaded to the S32K144EVB-Q100 or to the FRDMPT2001EVM.

7.2.1 Downloading microcode to the S32K144EVB-Q100

The procedure for downloading microcode to the S32K144 device on the S32K144EVB-
Q100 consist of the following steps:

1. Installing NXP's S32 Design Studio.
2. Downloading the S32K144EVB-Q100 example project file.
3. Importing the example project file into S32 Design Studio.
4. Customizing (optional) and building the example project file firmware image.
5. Downloading the firmware image to the S32K144EVB-Q100.

The following sections describe each of these steps in detail.
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7.2.1.1 Installing S32 Design Studio

NXP’s S32 Design Studio allows developers to customize the S32K144EVB-Q100's
MCU code to meet application-specific requirements. The S32 Design Studio IDE is
a complimentary integrated development environment that enables editing, compiling
and debugging of automotive and ultra-reliable designs. Based on free, open-source
software including Eclipse IDE, GNU Compiler Collection (GCC) and GNU Debugger
(GDB), the S32 Design Studio IDE is a straightforward development tool with no code
size limitations.

This procedure explains how to obtain and install the latest version of S32 Design Studio.
If S32 Design Studio is already installed on the host PC, skip this section.

1. Obtain the latest S32 Design Studio installer file from the NXP website www.nxp.com/
S32DS.

2. Run the executable file and follow the instructions.

The S32 Design Studio SDK library is distributed with the IDE already integrated, so no
explicit action is required to add or link it manually.

7.2.1.2 Downloading the S32K144EVB-Q100 example file

The Software & Tools tab on the FRDMPT2001EVM tool summary page contains an
example microcode project file. This project demonstrates a typical application that
exercises the functionality of the fuel injectors and the fuel pump controllers. Developers
can download this file and edit the source code to accommodate their application.

To download the example file, do the following:

1. Go to the tool summary page at http://www.nxp.com/FRDMPT2001EVM and click on
the Software & Tools tab.

2. Locate and download the zip file named S32K144_PT2001_EXAMPLE.zip.
3. Unzip this file into a folder on the computer that has the S32 Design Studio installed.

7.2.1.3 Importing the example file

Once the demo file has been downloaded, the developer must import it into S32 Design
Studio. The procedure is as follows:

1. Open S32 Design Studio.
2. From the S32 Design Studio menu bar, click File -> Import. A Select window opens.
3. In the Select window, expand the folder named General. Then select Existing

Projects into Workspace and then click Next. An Import Projects  window opens.
4. In the Import Project window, browse for and select the root directory containing the

example file. In the Projects panel, select the example file. Then click Finish. See
Figure 9.

http://www.nxp.com/S32DS
http://www.nxp.com/S32DS
http://www.nxp.com/FRDMPT2001EVM
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Figure 9. Import projects dialog

The example file appears in the Project Explorer panel on the left side of the IDE.

7.2.1.4 Customizing and building the example file

Developers can flash the MCU on the S32K144EVB-Q100 with the unmodified example
file microcode. The source code can also be modified to meet the specific requirements
of their application. In either case, the project must be built in S32 Design Studio before
downloading the microcode.

1. To customize the example file, expand the example project tree in the Project
Explorer window to view the file folders. The source code is located in the src folder
and the include files are located in the include folder. Double-clicking the file name in
the Project Explorer opens the file for editing where changes can be made.

2. To build the project, select the project in the Project Explorer window, then click the
hammer icon on the S32 Design Studio toolbar. If there are no errors during the build,
the output file is located in the Debug folder under the main project folder. The file has
a .srec extension (example: S32K144_PT2001_EXAMPLE.srec).
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Figure 10. S32 Design Studio build project

7.2.1.5 Downloading the firmware to the S32K144EVB-Q100

1. Connect the micro-B plug on the USB cable to the USB port on the S32K144EVB-
Q100 board. Connect the USB cable’s Standard A plug to the host PC. An icon
named EVB-S32K144 appears as a removable drive on the host PC.

2. To download the firmware, locate the firmware file
(S32K144_PT2001_EXAMPLE.srec) on your computer and drag and drop the file
onto the EVB-S32K144 icon.

The firmware program begins running immediately after the download has completed.

7.2.2 Updating microcode on the FRDMPT2001EVM

This section provides an overview of the process for updating the microcode on the
FRDMPT2001EVM. For information on the process, see PT2001 Developer Studio
User’s Guide (PT2001_IDEUG).

The procedure is as follows:

1. Install NXP’s PT2001 Developer Studio.
2. Load, build and regenerate the example projects.
3. Update the S32K144EVB-Q100 with the new project data.

7.2.2.1 Installing PT2001 Developer Studio

1. Obtain the latest version of the PT2001 Developer Studio installer file from the NXP
website: http://www.nxp.com/products/power-management/engine-and-dc-motor-

http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-PT2001-programmable-%20solenoid-controller:PT2001IDE?tab=Design_Tools_Tab
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control/powertrain-engine-control/developer-studio-for-PT2001-programmable-
%20solenoid-controller:PT2001IDE?tab=Design_Tools_Tab

2. Run the executable file and follow the wizard instructions.

7.2.2.2 Loading, building and regenerating the example projects

Two relevant example projects — FRDMPT2001EVM Software Files for Peak and Hold
with Diagnostics and DCDC and FRDMPT2001EVM Software Files for Peak and
Hold and DCDC — are available on the FRDMPT2001EVM tool summary page.

These examples can be used as starting points for developing application specific
microcode. For information on how to load and build projects using the IDE, see PT2001
Developer Studio User’s Guide  which can be accessed using the Help menu on the IDE.

After successfully building a project, the PT2001 load data files must be regenerated. To
do this,

• In the PT2001 Developer Studio toolbar, select Tools -> Generate PT2001 Load
Data Code. When the regeneration process completes, the Code Generation Results
window appears as shown in Figure 11.

Figure 11. Code generation results

7.2.2.3 Updating the S32K144EVB-Q100

1. In Windows Explorer, open the folder that the generated code files were saved to.
Locate the files PT2001_LoadData.h and PT2001_LoadData.c (usually found in
the folder named sample_code). These files contain the code RAM, data RAM, and
register settings that get loaded into the PT2001. The PT2001 Developer Studio also
creates other files that may be useful when creating a new MCU project from scratch.
See the PT2001 Developer Studio User’s Guide, available at http://www.nxp.com/
assets/documents/data/en/user-guides/PT2001-IDEUG.pdf for a description of these
files and how they are used.

2. To update the S32 design studio project, copy PT2001_LoadData.c over the
existing file in the src folder of the S32 Design Studio project, and copy the
PT2001_LoadData.h file over the existing file in the include folder.

3. To run the updated microcode on the EVB, rebuild the project and reload the
S32K144EVB-Q100 board as described in Section 7.2.1.5 "Downloading the firmware
to the S32K144EVB-Q100".

8 Schematics, board layout and bill of materials

The board schematics, board layout and bill of materials are available at http://
www.nxp.com/FRDMPT2001EVM on the Overview tab under Get Started.

http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-PT2001-programmable-%20solenoid-controller:PT2001IDE?tab=Design_Tools_Tab
http://www.nxp.com/products/power-management/engine-and-dc-motor-control/powertrain-engine-control/developer-studio-for-PT2001-programmable-%20solenoid-controller:PT2001IDE?tab=Design_Tools_Tab
http://www.nxp.com/assets/documents/data/en/user-guides/PT2001-IDEUG.pdf
http://www.nxp.com/assets/documents/data/en/user-guides/PT2001-IDEUG.pdf
http://www.nxp.com/FRDMPT2001EVM
http://www.nxp.com/FRDMPT2001EVM
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11 Legal information

11.1  Definitions
Draft — The document is a draft version only. The content is still under
internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included herein and shall have no liability for the consequences
of use of such information.

11.2  Disclaimers
Limited warranty and liability — Information in this document is believed
to be accurate and reliable. However, NXP Semiconductors does not
give any representations or warranties, expressed or implied, as to the
accuracy or completeness of such information and shall have no liability
for the consequences of use of such information. NXP Semiconductors
takes no responsibility for the content in this document if provided by an
information source outside of NXP Semiconductors. In no event shall NXP
Semiconductors be liable for any indirect, incidental, punitive, special or
consequential damages (including - without limitation - lost profits, lost
savings, business interruption, costs related to the removal or replacement
of any products or rework charges) whether or not such damages are based
on tort (including negligence), warranty, breach of contract or any other
legal theory. Notwithstanding any damages that customer might incur for
any reason whatsoever, NXP Semiconductors’ aggregate and cumulative
liability towards customer for the products described herein shall be limited
in accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to
make changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
notice. This document supersedes and replaces all information supplied prior
to the publication hereof.

Suitability for use — NXP Semiconductors products are not designed,
authorized or warranted to be suitable for use in life support, life-critical or
safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
to result in personal injury, death or severe property or environmental
damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer’s own
risk.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes
no representation or warranty that such applications will be suitable
for the specified use without further testing or modification. Customers
are responsible for the design and operation of their applications and
products using NXP Semiconductors products, and NXP Semiconductors
accepts no liability for any assistance with applications or customer product
design. It is customer’s sole responsibility to determine whether the NXP
Semiconductors product is suitable and fit for the customer’s applications
and products planned, as well as for the planned application and use of
customer’s third party customer(s). Customers should provide appropriate
design and operating safeguards to minimize the risks associated with

their applications and products. NXP Semiconductors does not accept any
liability related to any default, damage, costs or problem which is based
on any weakness or default in the customer’s applications or products, or
the application or use by customer’s third party customer(s). Customer is
responsible for doing all necessary testing for the customer’s applications
and products using NXP Semiconductors products in order to avoid a
default of the applications and the products or of the application or use by
customer’s third party customer(s). NXP does not accept any liability in this
respect.

Suitability for use in automotive applications — This NXP
Semiconductors product has been qualified for use in automotive
applications. Unless otherwise agreed in writing, the product is not designed,
authorized or warranted to be suitable for use in life support, life-critical or
safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
to result in personal injury, death or severe property or environmental
damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer's own
risk.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Evaluation products — This product is provided on an “as is” and “with all
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates
and their suppliers expressly disclaim all warranties, whether express,
implied or statutory, including but not limited to the implied warranties of
non-infringement, merchantability and fitness for a particular purpose. The
entire risk as to the quality, or arising out of the use or performance, of this
product remains with customer. In no event shall NXP Semiconductors, its
affiliates or their suppliers be liable to customer for any special, indirect,
consequential, punitive or incidental damages (including without limitation
damages for loss of business, business interruption, loss of use, loss of
data or information, and the like) arising out the use of or inability to use
the product, whether or not based on tort (including negligence), strict
liability, breach of contract, breach of warranty or any other theory, even if
advised of the possibility of such damages. Notwithstanding any damages
that customer might incur for any reason whatsoever (including without
limitation, all damages referenced above and all direct or general damages),
the entire liability of NXP Semiconductors, its affiliates and their suppliers
and customer’s exclusive remedy for all of the foregoing shall be limited to
actual damages incurred by customer based on reasonable reliance up to
the greater of the amount actually paid by customer for the product or five
dollars (US$5.00). The foregoing limitations, exclusions and disclaimers
shall apply to the maximum extent permitted by applicable law, even if any
remedy fails of its essential purpose.

Translations — A non-English (translated) version of a document is for
reference only. The English version shall prevail in case of any discrepancy
between the translated and English versions.

11.3  Trademarks
Notice: All referenced brands, product names, service names and
trademarks are the property of their respective owners.
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